
Tutorial de Familias 

Por: Daniel Kling, Lourdes Prieto and 
Thore Egeland 

Actualizado el 29/Sept/2022 

1 



Prefacio 

Este tutorial describe las características básicas de Familias. La presente versión del 
tutorial se basa en la versión 3.3 de Familias, pero debe funcionar 
razonablemente bien para las versiones 3.2.2 y posteriores 
 

 

Para una descripción más detallada y para entender el soporte teórico del software 
consulte el manual disponible en http://www.familias.no, y las publicaciones que 
aparecen listadas en el mismo link. 

 

La versión en inglés de este documento (Daniel Kling, Lourdes Prieto and  
Thore Egeland) se encuentra en http://familias.no/espana/ 

 

Puede consultar videos que incluyen soluciones a ejercicios en Egeland, Kling, Mostad 
(2015), ver https://familias.name/VideosBook.pdf 
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1. Lo básico. Un caso de paternidad en 
cuatro pasos 
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Input file: tutorial-Ch1.fam 

http://familias.name/tutorial/tutorial-Ch1.fam
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Ejemplo para presentar Familias 
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Considere 
 
• H1: AF padre de CH (figura) 
• H2: AF y CH no relacionados 

 
Calculamos los LRs por marcador: 

Ahora explicaremos los cuatro pasos necesarios para verificar los cálculos usando Familias 

D3S1358= 
TPOX = 
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Cuatro pasos básicos 
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1. Datos Generales de ADN (General DNA data). Cargar la base de 
datos, es decir, las frecuencias alélicas, etc. 

2. Personas (Persons).  Individuos necesarios para definir los pedigríes. 
3. Datos de ADN del caso (Case DNA data). Genotipos  
4. Pedigríes (Pedigrees). Definición de las hipótesis y cálculo 

 



Paso1: Datos Generales de ADN 
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• Clic en Add (Añadir) para definir un nuevo marcador. Se abrirá una ventana donde podrá 
introducir los datos como se muestra en la figura. 

• Haga lo mismo para el siguiente marcador (TPOX) que presenta los alelos 8 y 9, con frecuencias 
de 0.554 y 0.104, respectivamente.  

• Se puede modificar el orden de los marcadores usando los botones “Move up” o “Move down”.   



Paso 1 en detalle: datos Generales de ADN 

Familias - Tutorial 8 

La ventana “Edit database” se abre  La ventana “New marker” se abre Clic  

2 

Añadir el nombre del primer marcador (D3S1358 en el ejemplo)  3 

Añadir el primer alelo (17), frecuencia  (0.204) y presionar ‘Add’  4 

Hacer lo mismo con el segundo alelo (18, frec. 0.1394)  5 

Clic ‘Save’ y aparecerá:  6 

Para “Escalar”, clic Sí (la frec. de los dos alelos 
cambiará para que sumen 1)  
Para “añadir un alelo más”, clic No (se añadirá un 
alelos más, rest allele, con frec. 0.6566) 

7 

Repetir el proceso para el segundo marcador (TPOX, en el ejemplo)  8 

Clic  

1 



Paso 2. Personas 
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• Introduzca las personas: AF (presunto padre), y CH (hijo) como se muestra en la figura 
• La información sobre el ‘Role’, ’Year of birth’, ‘Is child’ no se necesita ni se usa 

normalmente. 
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Paso 2 en detalle: personas 

Clic  

1 

Introducir el nombre de la primera persona (AF)  2 

Opcional: introducir el año de nacimiento  3 

Introducir el género  4 

Clic ‘Add’  5 

Se abre la ventana “Persons”  

2 
3 

4 
5 

Hacer lo mismo con la siguiente persona (CH)  6 

Comentario 1 
Si introduce el año de nacimiento, se asegura 
de que una persona joven no puede ser el 
progenitor de una más vieja (útil para evitar 
errores en los pedigríes y en pedigríes 
imposibles) 

Comentario 2 
Si hace clic in la casilla “Is child”, se asegurará 
de que esta persona no puede tener hijos (útil 
por las mismas razones que anteriormente) 



Paso 3. Datos del caso 

11 

• Haga doble clic en cada persona. En la nueva ventana, seleccione el marcador 
presionando en el menú, seleccione los alelos, presione Add y OK. Obtendrá los 
datos como se muestra en la figura. 
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Paso 3 en detalle: Datos del caso 
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Clic  

1 

Se abre la ventana “Case-related DNA data”  

Doble Click  (AF) 

2 

Seleccione el marcador (D3S1358)  3 

Introduzca el genotipo (17-18) 4 

Clic ‘Add’  5 

Haga lo mismo con TPOX y “close”  6 

Se abre la ventana “Add/Edit DNA data”  

3 4 5 

Repita el proceso desde         para CH 7 2 

Comentario 
Si quiere considerar drop-out en un individuo 
específico, clic en la casilla. Vea la diapositiva 18 
para introducir la probabilidad de drop-out   



Paso 4. Pedigríes 
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• Clic en Add para introducir las hipótesis “H1: Padre” como se muestra en la figura (panel 
superior). 

• Introducir el pedigrí “H2: no relacionado”. En este caso no hay que añadir ninguna relación. 
• Haga clic en Calculate (calcular) para obtener lo que se muestra en la figura (panel inferior). 

Familias - Tutorial 



Paso 4 en detalle: Pedigríes 
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Clic  

1 

Se abre la ventana “Pedigrees”  Clic  

2 

Nombre el pedigrí (ej., H1: Father)  3 

Defina la relación (AF padre de CH) 4 

Clic ‘Add’  5 

Nombre el segundo pedigrí (H2: unrelated). En 
este caso no tiene que definir ninguna relación   

6 

Clic ‘Close’  7 

Se abre la ventana “Add Pedigree”   

3 

4 5 

Comentario 1 
Familias solo permite definir 
relaciones progenitor-hijo/a. Si quiere 
definir la relación “2 hermanos”, tiene 
que introducir una madre y un padre, 
y establecer que ambos son sus hijos.  
  
Comentario 2 
Para definir un mach directo, ej. 
gemelos, usar la opción Direct/Identity 

7 

Ahora clic en ‘Calculate’ de la 
ventana Pedigrees para 
obtener:  

8 



2. Complicaciones 
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Mutaciones 

Familias - Tutorial 16 

Clic  

1 

Clic  

2 

3 4 

• Vaya al paso 1 (      ), la ventana de la base de datos y presiones ‘Mutations’ (      )  para 
obtener la ventana “Mutation options”. 

• Hay cinco modelos de mutación (ver el manual para más  información) 
• Se puede seleccionar el modelo para todos los marcadores (      ) o sólo para los 

seleccionados (      ), como se muestra en la figura.  

1 2 

3 
4 

    



Modelos de mutación en Familias 
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Modelo Simple  
Todas las mutaciones ocurren con igual probabilidad. Apropiado cuando se necesita que los 
cálculos sean rápidos (ej. Pedigríes complejos y DVI) y también para marcadores tipo SNP. 
Proporcional a la frecuencia 
Las mutaciones ocurren con probabilidad proporcional a la frecuencia del nuevo alelo 
generado. Si la frecuencia es baja, la probabilidad de mutación será baja. Apropiado para 
probar propiedades estadísticas de los cálculos. 
Modelo Stepwise 
El modelo tradicional en el que se tiene en cuenta el número de steps entre el alelo origen 
y la versión mutada, decreciendo la probabilidad para mutaciones que implican más 
repeats. Apropiado para marcadores STR sin microvariantes. 
Modelos Stepwise estable 
El modelo  Stepwise tradicional, en el cual las probabilidades de mutación se han ajustado 
para crear una matriz de mutación estable. Apropiado para pruebas de propiedades 
estadísticas de los cálculos. 
Modelo Stepwise extendido (RECOMENDADO) 
El modelo Stepwise más completo, donde se tienen en cuenta tanto repeats exactos como 
microvariantes. Apropiado para todos los marcadores STR. 



Alelos silentes y Dropout 
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Clic  

1 

4 

5 

• Entrar en la ventana Database (      ), doble clic en el marcador para editarlo (      ). 
• Clic en Options (       ) y aparece la ventana en la que se puede introducir la frecuencia 

del alelo silente  (       ) y/o la probabilidad de Dropout (       ). 
• En el caso del Dropout , se requiere hacer algo más en la pestaña de Case DNA para 

especificar en qué individuos debemos tener en cuenta el dropout (ver diapo 12). 

1 2 
3 
4 5 

Doble Clic  

2 
3 

Comentario 1 
Nótese que no 
afecta a los 
resultados cambiar 
el tamaño de la base 
de datos.  
 
Comentario 2 
Definir una 
frecuencia mínima 
distinta de cero sólo 
tiene efecto una vez 
que se chequea la 
opción Advanced 



Endogamia: Pedigríes complejos 

• Dibuje el pedigrí 

• Identifique las personas necesarias para definir el 
pedigrí: personas que serán analizadas y personas 
que no serán analizadas (extra persons). 

• Introducir todas las personas requeridas (Paso 2) y 
los pedigríes (Paso 4). 
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Comentario: Las persons 202 y 203 no son necesarias, pero la función de dibujo (ploting) 
las introduce . La línea doble que conecta 101 y 102 indica endogamia, es decir, que los 
dos progenitores están relacionados familiarmente, dentro del propio pedigrí. 
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Corrección Theta 
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Clic  

1 

3 Clic  2 

• Click en ‘Parameters’ (parámetros) en la ventana de Pedigríes (       ). Hemos introducido el valor 0.01 
(       ). 

• Los parámetros a priori (‘Prior parameters’) prácticamente nunca se cambian: no tienen impacto en 
el LR, sólo lo tienen en la probabilidad a priori (y por lo tanto en la probabilidad a posteriori).  

2 
3 



Más opciones en la ventana “Pedigree” 

Familias - Tutorial 
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Genera pedigríes, ver dispositivas siguientes 

Elije  el a priori para H1 y H2, 
sólo afecta al  a posteriori 

Dibuja el pedigrí, ver Sección 3 

Para elegir marcadores a 
excluir en el cálculo 

Selecciona el denominador del LR: 
marcando H1 y presionando “Scale” 
obtiene el LR para H2 vs. H1 

Importa pedigríes, ver diapositiva siguiente 

Exporta pedigríes 



Creación de  pedigríes en QuickPed, 
importación a Familias 
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• La siguiente diapositiva muestra la app QuickPed (Vigeland, 2022), una 
herramienta online para dibujar pedigríes y analizar parentesco, que también 
se puede usar para crear pedigríes. 

• Como se explica a continuación, los pedigríes se pueden importar a Familias 

https://magnusdv.shinyapps.io/quickped/
https://bmcbioinformatics.biomedcentral.com/articles/10.1186/s12859-022-04759-y


24 

1. Cree el pedigrí por ejemplo en QuickPed:  https://magnusdv.shinyapps.io/quickped/  
2. Salve el archivo .ped de QuickPed 
3. Opcional: puede ver el archivo .ped en tutorial.ped 
4. Importe el archivo tutorial.ped en Familias 
5. Ya tiene el archivo .ped incorporado en Familias 

https://magnusdv.shinyapps.io/quickped/
http://familias.name/tutorial/tutorial.ped


Generar pedigríes 
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Cuestión de interés: ¿Cuál es la relación entre los 4 niños C1, C2, C3 and C4? 
¿Hermanos, medio hermanos o no están relacionados? 

Definir que son niños, es decir, no 
pueden ser padres 

Definir fechas de nacimiento de 
los padres (nacidos el mismo año 
para que no puedan ser padres 
unos de otros, evitando así varias 
generaciones) 

Comentario 
Ver el test de suficiencia ESWG de 2021: ejercicio con video y presentación 

http://familias.name/ESWG/ESWG_Paper_challenge_2021.pdf
http://familias.name/ESWG/kling_eswg2021_pt_test.mp4
http://familias.name/ESWG/ESWG - Proficiency test 2021.pptx


Generar pedigríes 
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Cuestión de interés: ¿Cuál es la relación entre los 4 niños C1, C2, C3 and C4? 
¿Hermanos, medio hermanos o no están relacionados? 

Opciones para generar pedigríes 
a. Incluir hombres/ mujeres extra (no 

recomendado) 
b. Eliminar pedigríes redundantes 

(recomendado) 
c. No generar pedigríes con padres 

solteros (recomendado) 
d. No generar pedigríes con hijos 

únicos (recomendado) 
e. No tener en cuenta el género 

(opcional) 

Generar pedigríes 



Generar pedigríes 
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Cuestión de interés: ¿Cuál es la relación entre los 4 niños C1, C2, C3 and C4? 
¿Hermanos, medio hermanos o no están relacionados? 
 
Familias generará todos los pedigríes posibles con las restricciones impuestas por las 
personas y las opciones definidas. También generará, por ejemplo, pedigríes donde 
un individuo tenga un único progenitor y en los que ni el individuo ni el progenitor 
estén genotipados. Estos pedigríes no se generan si se han seleccionado las opciones 
“peel”. La opción “Disregard genders” considerará que los pedigríes “medio 
hermanos paternos” y “medio hermanos maternos” son idénticos y por lo tanto el 
software los considerará como duplicados. 
 
Puede restringir el número de pedigríes generados si algunas de las relaciones de 
parentesco son conocidas y lo define así en la ventana ‘Known relationship’: 
 
 



Generar pedigríes con restricciones: ejemplo 
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Ped-1 

Ped-4 

Ped-2 Ped-3 

Ped-5 Ped-6 

Ped-7 Ped-8 Ped-9 

Ped-10 Ped-11 Ped-12 

1-1 1-2 

Frec. 1 = 0.1; Frec. 2 = 0.9; sin mutación 

La función “Generate” por defecto (sin 
restricciones) ofrece los 12 pedigríesde la 
izquierda (archivo peel.fam) 
• Si se aplican las siguientes restricciones:  

• Remove redundant 
• Peel single parents 
• Peel single children 

       Se obtienen los pedigríes 1, 3, 6, 8, 10 ,12 
• Si el parámetro Inbreeding se pone en 0 se 

obtiene un LR=0 para los pedigríes 8 y 12. 

https://familias.name/tutorial/peel.fam


3. R Familias, paramlink, plotting y blog 
Parentela 

 

29 Familias - Tutorial 

https://parentela.familias.name/
https://parentela.familias.name/


¿Qué es        ? 

• Un marco para realizar cálculos estadísticos y numéricos 

– calculadora 

– Dibujo de figuras y gráficos flexible 

– Gran núcleo de funciones para el manejo de datos  y el análisis numérico 

– Lenguaje de programación 

– Paquetes (conjuntos de funciones) externos 

• Cualquiera puede hacer uno 

• Hay miles!  

 

• Sobre R: 

– Se encuentra disponible gratuitamente en https://cran.r-project.org/ 

– Ampliamente utilizado 

– Puede hacer cualquier cosa (pero puede no ser fácil) 
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Instalación y carga de la librería Familias de R 

Para acceder a las funciones de una librería externa en R, tomando como ejemplo la librería 
de Familias, se debe: 
 

• Instalar el paquete, esto se hace sólo una vez. Lo siguiente funcionará en la mayoría de 
plataformas (más detalles  aquí):  

 

 install.packages("https://familias.name/RFamilias/Familias_2.5.zip", repos = NULL, 
type = "win.binary")   #(se necesita conexión a internet)  

 

• Cargar la librería en  R, se hace cada vez que se inicia una sesión en R: 

 library(Familias) 
 

Para obtener ayuda, teclee 

  help(Familias) 
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https://www.familias.name/openfamilias.html


Ejemplo de sesión desde help("FamiliasPosterior"):  
copiar y pegar en R! 
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library(Familias) 
persons <- c("mother", "daughter", "AF") 
ped1 <- FamiliasPedigree(id=persons, dadid=c(NA, "AF", NA), momid=c(NA, "mother", NA),  
                         sex=c("female", "female", "male")) 
ped2 <- FamiliasPedigree(id=c(persons, "TF"), dadid=c(NA, "TF", NA, NA),  
                         momid=c(NA, "mother", NA, NA),  
                         sex=c("female", "female", "male", "male")) 
ped3 <- FamiliasPedigree(id=c(persons, "TF", "gf", "gm"), dadid = c(NA, "TF", "gf", "gf", NA, NA),  
                         momid=c(NA, "mother", "gm", "gm", NA, NA),  
                         sex=c("female", "female", "male", "male", "male", "female")) 
X11() 
plot(ped1);title("ped1, i.e., AF is father") 
mypedigrees <- list(isFather = ped1, unrelated=ped2, isUncle = ped3) 
locus1 <- FamiliasLocus(frequencies=c(0.1, 0.2, 0.3, 0.4),  
                        allelenames= c("A", "B", "C", "D"), name="locus1") 
locus2 <- FamiliasLocus(c(0.2, 0.3, 0.5), c(17, 18, 19), "loc2", femaleMutationRate = 0.05) 
myloci <- list(locus1, locus2) 
datamatrix <- data.frame(locus1.1=c("A", "A", "A"), locus1.2=c("B", "B", "C"),  
                         locus2.1=c(17, 19, 19), locus2.2=c(18, 18, 18)) 
rownames(datamatrix) <- persons 
result = FamiliasPosterior(mypedigrees, myloci, datamatrix,ref=2) 
result 



Código R generado desde Familias (modo windows) 
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• Familias exporta a R el código necesario para: 

 Dibujar pedigríes 

 Hacer simulaciones condicionadas 

 Calcular la probabilidad de exclusión 

 … 

• La exportación se hace desde Familias (modo Windows): 

  File >  Export to R-Familias (se exporta todo) 

 ‘Plot in R’ en la ventana Edit Pedigree (para dibujar el pedigrí) 

 Simulaciones condicionadas en el módulo DVI 
 



Blog Parentela 

• Genética forense y probabilidad 

• https://parentela.familias.name/category/category5/ 
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¿No os acordáis?  
sen^2 x + cos^2 x = 1  
:)))))) 

https://parentela.familias.name/category/category5/
https://parentela.familias.name/category/category5/
https://parentela.familias.name/category/category5/


4. Simulaciones 
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Simulaciones 

Familias - Tutorial 36 

Clic  

1 

2 

3 

4 

5 

• En la ventana Pedigrees  (      ), una vez definidas las hipótesis que quiere simular, clic 
‘Simulate’ (      ). Se abrirá la ventana Simulation. 

• Seleccione los individuos que serán genotipados  (      ) haciendo clic sobre ellos y 
después sobre las flechas (      ). Esos individuos se moverán a la casilla “will be 
genotyped” (      ). 

1 
2 

3 

4 
5 



Simulaciones - Opciones 
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Puede elegir el número de simulaciones (1000 por defecto)  1 

Puede salvar el dato bruto (genotipos y/o LRs) en un archivo .txt 2 

Puede realizar simulaciones con todos los marcadores de la 
base de datos de frec. o sólo con los seleccionados en el 
diálogo de la ventana Pedigrees (Included systems)  

3 

Puede especificar dónde comenzará la simulación (Seed).  4 

Clic ‘Simulate’  5 

Si usa “Random seed”,  se 
obtendrán diferentes 
simulaciones cada vez que 
lleve a cabo una simulación.  

Si no usa “Random seed”, tiene 
que introducir un número, y 
obtendrá exactamente el mismo 
resultado tras diferentes 
simulaciones (si todos los demás  
valores/parámetros no se cambian 
y si usa siempre el mismo número 
en  Seed).  

1 

2 

3 

4 

5 



Simulaciones - Resultados 
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Significado de la primera fila de la figura (H2: “AF y CH are unrelated” ES CIERTA):  
No se esperan valores de LR = 0 ya que en el ejemplo se ha tenido en cuenta la mutación (tasa 
0.001 y rango 0.1).  Sin embargo, se esperan valores de LR bajos ya que la hipótesis cierta es la de 
“no relación” entre AF y CH. 
La media de los valores de LR obtenidos es 0.99 
El 50% de las simulaciones están por debajo (y por encima) de la mediana 0.7715 
El 95% de las simulaciones da un valor de LR por debajo de 2.746 
El 5% de las simulaciones da un valor de LR por debajo de 0.0003981 
 
Significado de la segunda fila de la figura (H1: “AF is the father of CH” ES CIERTA): 
La media de los valores de LR obtenidos es 1.874 
50% de las simu. está por debajo de la mediana 1.54 
95% de las simulaciones está por debajo de 4.008 
5% de las simulaciones está por debajo de 0.6872 
 
Puede usar este archivo para reproducir  
estos resultados 

Comentario 
Los valores de LR bajo ambas situaciones (H1 
cierta y H2 cierta) se solapan. Así que no 
seremos capaces de llegar a ninguna conclusión 
sobre la paternidad si sólo analizamos estos 2 
marcadores (con 3 y 2 alelos).  

http://familias.name/tutorial/example-tutorial.fam
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Simulaciones – Un ejemplo “más real” 

Significado de la primera fila de la figura (H2: “AF and CH are unrelated” ES CIERTA):  
No se esperan valores de LR = 0 ya que en el ejemplo se ha tenido en cuenta la mutación (tasa 
0.001 y rango 0.1).  Sin embargo, se esperan valores de LR bajos ya que la hipótesis cierta es la de 
“no relación” entre AF y CH. 
La media de los valores de LR obtenidos es 1.018e-09 
El 50% de las simulaciones están por debajo de la mediana 4.051e-31 
El 95% de las simulaciones da un valor de LR por debajo de 8.159e-17 
El 5% de las simulaciones da un valor de LR por debajo de 2.145e-47 
 
Significado de la segunda fila en la figura (H1: “AF is the father of CH” ES CIERTA): 
La media de los valores de LR obtenidos es 6.317e+08 
50% de las simus. Está por debajo de la mediana 4.418e+06 
95% de las simulaciones está por debajo de 1.101e+09 
5% de las simulaciones está por debajo de 3.319e+04 

Mismas hipótesis, mismas opciones de simulación (1000 simus, todos los marcadores, Seed 
12345), pero 16 marcadores aSTR con frecuencias alélicas reales (PP ESX17) 

Comentario 
Los valores de LR bajo ambas 
situaciones (H1 cierta y  H2 cierta) NO 
se solapan. Podremos alcanzar una 
conclusión sobre la paternidad 

Puede usar este archivo 
para reproducir los 

resultados 

http://familias.name/tutorial/simu-16markers.fam


Simulaciones – LR limit 
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Útil para ver los resultados de una forma más fácil de entender 
El botón “LR limit” se utiliza para encontrar la fracción de simulaciones que excede un umbral de LR 

1 

4 

2 

3 
• Clic en LR limit (      ). Se abre la ventana 

“Simulation limits”. 
• Seleccione su umbral de LR (      ), 1000 por 

ejemplo, y clic “Update” (      ).  
• Obtendrá la información en         . 

1 

2 
3 

4 

Significado 
Si su umbral de LR = 1000, no se 
esperan falsos positivos si analiza 16 
marcadores. Los falsos negativos son 
muy pocos (ya que el 99.8% de las 
simulaciones dio LRs ≥ 1000) 

Falso positivo significa LR ≥ 1000 si H2 es cierta 
Falso negativo significa LR ≤ 1000 si H1 es cierta 



Simulaciones – Más información 
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• Recomendamos al menos 1000 simulaciones para obtener una idea de la 
distribución de LRs. Sin embargo, para explorar posibilidades más extremas, se 
debe realizar un número mucho mayor de simulaciones, por ejemplo 100,000. 

• Recomendamos usar «random seed» como norma general, mientras que se debe 
usar «fixed seed» (ej., 12345) cuando necesitamos que los resultados sean 
reproducibles, por ejemplo en las publicaciones. 

• Consejo: El dato bruto exportado con la información de los genotipos, puede 
usarse como entrada (input) en Familias. Por ejemplo, si simulamos datos para un 
escenario DVI (ver Sección 6), los datos de las familias  pueden simularse y usarse 
como punto de partida. 

• El dato bruto de los LRs obtenidos se puede exportar desde la ventana de 
resultados. Recomendamos usar el logaritmo del LR ya que la distribución de LRs 
resultante se aproxima a una distribución Normal. Ver ejemplos en las páginas 
siguientes. 



Gráficos de las simulaciones I. Lo que tiene que 
hacer en Familias 
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• Descargue el archivo localizado en 
http://familias.name/tutorial/Basics-sim.fam  
y realice 100 simulaciones usando las siguientes opciones 

http://familias.name/tutorial/Basics-sim.fam
http://familias.name/tutorial/Basics-sim.fam
http://familias.name/tutorial/Basics-sim.fam


Gráficos de las simulaciones II. Excel 
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• Obtendrá un archivo que podrá visualizar en Excel. Si es experto en Excel también 
podrá obtener la representación gráfica de los datos (si no es experto, ver las páginas 
siguientes).  

• Puede organizar los datos en Excel (Datos > las opciones de filtrado pueden 
ser útiles) 



Gráficos de las simulaciones III. Formato de los 
datos para introducir en R. 
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• Puede insertar gráficos y hacer más análisis en Excel (no se explica en este Tutorial). 
• Si prefiere usar R, guarde el archivo de Excel como archivo de texto delimitado por 

tabulaciones, con el formato que se indica en la figura (puede llamarlo Sim.txt). Tenga 
en cuenta que: 
 Los nombres de las Variables tienen que cumplir los requisitos de R  

(por ejemplo, ‘TRUEPED’, no ‘TRUE PED’) 
 Los Valores de las variables también tienen que cumplir los requisitos de R: 

Podemos usar por ejemplo ‘H1.father’, pero no ‘H1:father’ o ‘H1 Father’. 
 



Gráficos de las simulaciones IV. Usando R 
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dat = read.table("http://familias.name/tutorial/Sim.txt", header = TRUE) 
summary(dat) # Check data 
dat = dat[dat$TRUEPED == "H1", ] #Extracts data for hypothesis H1 
summary(dat) 
logLR = dat$logH1 - dat$logH2 # Calculates log (=ln , i.e., base=e) of LR 
hist(logLR, xlab = "logLR", ylab = "count",  main ="logLR (lnLR)")  
boxplot(logLR, ylab ="logLR") 
LR = exp(logLR) 
hist(LR, xlab = "LR", ylab = "count ", main ="LR")  
boxplot(LR, ylab ="LR") 

• Proporcionamos un ejemplo para hacer gráficas en R, con el archivo ya en su formato 
correcto.  

• Puede copiar y pegar estos comandos en R, pero se requiere conexión a internet, ya 
que el archivo en cuestión se encuentra en el link de la primera línea de comandos 
(http://familias.name/tutorial/Sim.txt):  

http://familias.name/tutorial/Sim.txt
http://familias.name/tutorial/Sim.txt


Gráficos de simulaciones V. Alternativa 
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• Descargue el archivo localizado en 
http://familias.name/tutorial/Siblings-sim.fam 
y realice 1000 simulaciones usando las siguientes opciones 

Observe que la opción ”Save raw data” NO está seleccionada! 

http://familias.name/tutorial/Siblings-sim.fam
http://familias.name/tutorial/Siblings-sim.fam
http://familias.name/tutorial/Siblings-sim.fam


Gráficos de simulaciones VI. Alternativa 
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# Se mostrará un gráfica de función de densidad (distribución de los valores de logLR). Para usar este código se necesita 
conexión a internet 
dat = read.table("http://familias.name/tutorial/Sim2.txt", header = FALSE, skip=5) 
plot(density(log(dat$V1)), xlab= "log LR", ylab= "Density", col=1, lwd=2, main="", xlim=c(-20,20), ylim=c(0,0.2)) 
points(density(log(dat$V2)), col=1, lty=2, lwd=2, type= "l") 
legend("topright", c("H1: Siblings", "H2: Unrelated"), lwd=2,lty=1:2) 
# Next exceedance plots, i.e. the probability to exceed each treshold given each hypothesis 
dev.new() 
threshold <- exp(seq(log(0.01), log(20), length.out=1000)) 
eh1 = eh2 = threshold 
for (i in 1:1000) { eh1[i] = sum(log10(dat$V1)>threshold[i])/1000; eh2[i]= sum(log10(dat$V2)>threshold[i])/1000; } 
plot(x=threshold, y=eh1, lwd=2, ylab= "Exceedance probability" ,xlab= "log Threshold" , type= "l") 
points(x=threshold, y=eh2, lwd=2, lty=2 , type= "l") 
grid(); legend("topright", c("H1: Siblings", "H2: Unrelated"), lwd=2,lty=1:2) 

• Se pueden guardar los LRs obtenidos desde el diálogo de resultados para luego 
procesarlos como se muestra abajo 
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Gráficos de simulaciones VII 
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Significado 
Tras 1000 simulaciones 
- los valores de LR si H2 es cierta van  
desde 10-20 a 105 (más o menos) 
- los valores de LR si H2 es cierta van 
desde 10-5 a >1020  
 

Afortunadamente, la probabilidad de que 
el LR (para no relacionados) sea mayor 
que el LR (para hermanos) es pequeña, 
con R se estima que es de 0.002 (2 de 
cada 1000 simulaciones): 
 
sum(dat$V2 > dat$V1)/1000 

Con los datos del archivo http://familias.name/tutorial/Sim2.txt , obtendrá: 

http://familias.name/tutorial/Sim2.txt


Simulaciones condicionadas I 

Familias - Tutorial 49 

• Se tienen en cuenta los genotipos de los individuos analizados 
• Muy útiles en escenarios DVI, ya que los perfiles genéticos de referencia determinan 

cuán informativo es un pedigrí 
• Ejemplo: la referencia es el padre y la persona desaparecida es el hijo. Si el perfil 

genético del padre es raro, los valores de los LRs simulados tienden a ser más 
elevados que si el genotipo del padre fuera común.  

• Sólo se simulan perfiles genéticos compatibles con el perfil genético del padre 

  Father 

D3S1338 14-16 

D3S1338 Simulated 
child 

Simu1 14-14 

Simu2 14-16 

Simu2 16-17 

… … 

Sólo se simularán genotipos que 
tengan el alelo 14, o el 16, o 
ambos 
El software calcula el LR para cada 
genotipo simulado 



Simulaciones condicionadas II 
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Abrir la ventana Simulation desde la ventana Pedigrees  
Activar “Conditional” y seleccionar la diana a simular (en este caso, el hijo CH) 
Clic en Simulate 

1 

1 

2 

2 

Nota: Familias sólo simulará datos para la persona diana, teniendo en cuenta los genotipos ya 
analizados! No está disponible la opción para incluir/excluir personas  (las personas que aparecen  en 
“Will be genotype/Not genotyped” están en gris) 

Use los datos del archivo http://familias.name/tutorial/cond-simu-father-child.fam 

http://familias.name/tutorial/cond-simu-father-child.fam
http://familias.name/tutorial/cond-simu-father-child.fam
http://familias.name/tutorial/cond-simu-father-child.fam
http://familias.name/tutorial/cond-simu-father-child.fam
http://familias.name/tutorial/cond-simu-father-child.fam
http://familias.name/tutorial/cond-simu-father-child.fam
http://familias.name/tutorial/cond-simu-father-child.fam


Simulaciones condicionadas III 
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Se genera un R-script. 
Copiar y pegar el script en la consola R 



Simulaciones condicionadas IV 
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Los resultados aparecerán  en la pantalla de Familias 



5. Blind search  
(«búsqueda a ciegas») 
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Input file: tutorial-Ch5.fam 

http://familias.name/tutorial/tutorial-Ch5.fam
http://familias.name/tutorial/tutorial-Ch5.fam
http://familias.name/tutorial/tutorial-Ch5.fam


Propósito 

• Encontrar relaciones entre pares de perfiles genéticos.  
– Caso simple: 

 

 

 

 

 

 

• Podemos hacer las siguientes 6 comparaciones con los perfiles de la figura: 
– P1-P2, P1-P3, P1-P4, P2-P3, P2-P4, P3-P4 

• ‘Blind’ implica que se van a buscar relaciones fijas (no pedigríes explícitos) que 
incluyen: 
– Progenitor-hijo (Parent-Child), Hermanos (Siblings), Medio hermanos (Half-siblings), Coincidencia 

directa (idéntico perfil, Direct-match), Primos (Cousins), primos segundos (2nd cousins) 

• Por ejemplo, podríamos suponer que P1-P2 es muy probablemente un match 
directo (son la misma persona). De todas formas, también son posibles otras 
relaciones, aunque menos probables. 
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Cómo hacer Blind Search - Preliminares 
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1 2 

3 

• Definir General DNA data (marcadores y frecuencias)       , Personas          y 
Case DNA data (genotipos del caso)   

1 2 
3 

Familias - Tutorial 



La búsqueda 

56 

1 

2 4 

3 

5 

• Se inicia la búsqueda como se muestra en         (también se puede hacer Blind search en los 
módulos  DVI y Familial Searching; en estos casos, sólo hay que hacer el paso         de la página 
anterior antes de entrar en estos módulos) 
 

• Configuración de los parámetros: 
 Se mostrarán los LRs mayores que 0 (el valor por defecto es 1)  
 Theta, por defecto se usa 0  
 Comparaciones que se desean realizar       . En la figura: Parent-Child, Siblings, Half-siblings 
 Comparar con “no relacionado” (denominador del LR) 

1 

2 
3 

4 
5 

1 
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Resultado 
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• Se han estudiado 3 tipos de relaciones, y hay 6 comparaciones de parejas de perfiles 
(ver página 42), por tanto, la lista contiene 3*6=18 comparaciones. 

• La lista se ordena de acuerdo al valor del LR. 
• Sólo es posible establecer inconsistencias (marcadores que excluyen) en el caso de 

‘Parent-Child’ y se éstas se indican en la última columna;  
• En el Blind Search del módulo DVI, se pueden tener en cuenta mutaciones sólo en la 

relación de parentesco padre-hijo. 
Familias - Tutorial 



Direct match 

• En el caso de match directo, se pueden configurar más parámetros 
– Dropin param.        ,  Dropout           y Typing error  

– Ahora, el LR para P1-P2 LR se ha reducido a 9.6, mientras que otras comparaciones ahora dan LR>0 
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1 3 2 
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3 
 

 

 

1 
 

 

 

2 

    

1 

2 

3 



Opciones avanzadas e información obtenida 

• Hay más opciones, la mayoría son intuitivas y no se necesitan para las aplicaciones 
básicas. 

• Se puede obtener además información avanzada sobre alelos IBS (Idénticos por 
estado) y alelos IBD (Idénticos por descendencia). Esta información no es relevante 
para aplicaciones estándar. 
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6. DVI (Identificación de víctimas en 
desastres) 
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Puede encontrar información sobre características más avanzadas del módulo DVI, 
incluyendo simulaciones y análisis con varias bases de datos de frecuencias alélicas en 
un mismo proyecto en este link. 
 
Archivo necesario para la mayoría de los siguientes ejemplos en: Exercise.3.1.fam. La 
apariencia de algunas de las capturas de pantalla que mostramos en este tutorial 
pueden diferir ligeramente si utiliza las versiones más recientes de Familias. 

https://familias.name/tutorial/getting_started_Familias_DVI-Spain.pdf
https://familias.name/tutorial/Exercise.3.1.fam
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1. General DNA data. Carga de la base de datos, es decir frecuencias alélicas, etc. 
Descrito en detalle en la sección 1 de este tutorial.  

2. Unidentified samples (Muestras no identificadas).  Muestras que se quieren 
identificar, en un escenario DVI  es el conjunto de restos humanos sin 
identificar mientras que en un escenario de personas desaparecidas pueden 
ser individuos identificados  que se quieren reencontrar con sus familias 
biológicas. 

3. Reference families (Familias de referencia). Datos de referencia que se usarán 
para identificar y reagrupar familias con personas desaparecidas. 

4. Search (Búsqueda). Comparación e interpretación de resultados. 
 

Pasos Básicos 

 



Veremos el módulo DVI con un ejemplo 
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1. General DNA data:  
Un marcador con alelos 1 ,2, 3, 4 (todos frec = 
0.25) 

2. Unidentified samples:  
Tres muestras V1, V2 y V3 y sus genotipos. 

3. Reference families:  
Dos familias de referencia F1, F2 con sus 
individuos desaparecidos (hijos en este caso) M1 y 
M2. 
Datos genéticos de los familiares disponibles  
(madre y padre en F1, sólo el padre en F2.) 
 
 
 

• En este ejemplo “de juguete” ilustramos cómo se realiza la entrada de datos 
manualmente; es un ejercicio útil. 

• Para casos reales, los datos se pueden importar desde archivos. Esto se explica al final de 
esta sección. 

Familias - Tutorial 



Cómo proceder en DVI 
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1 

2a 

Defina el marcador       , y entre en el módulo DVI module > Add               
Introduzca las muestras no identificadas               . Presione Next  

1 2a 

2b 2c 

Familias - Tutorial 

Comentario 
La opción “Is 
entity?” está en 
Beta testing y 
permite al usuario 
especificar una  
familia/pedigrí en 
lugar de una 
persona sin 
identificar 

2b 

2c 



Definición de las familias de referencia 
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3a 

3b 

3c 

• Se ha definido la primera familia, 
presionamos ‘Add’              para introducir 
una nueva familia. 
 

• Nombramos la familia (F2) 
• Introducimos las personas necesarias para 

definir el pedigrí posteriormente e 
introducimos los genotipos (de las 
personas disponibles)  
 

3a 

3b 

3c 

Comentario 
En estas ventanas tiene que definir el 
nombre de la familia, los miembros que la 
forman y los perfiles genéticos (las 
relaciones entre estos miembros y con la 
persona desaparecida no se definen aquí) 



Definición de pedigríes, es decir,  qué parentesco se tiene con la 
persona desaparecida (MP) 
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3c 

3f 

• Vamos a Add              para definir el pedigrí 
• Nombramos el pedigrí 
• Definimos cómo está relacionada a MP con esta familia 
• NO tocar ‘Reference pedigree’,             , 

está ahí porque una MP puede no pertenecer a ninguna de las familias de referencia. 
• Cuando haya definido todo, presione ‘Next’ para hacer la búsqueda …. 
• Nota: para definir una muestra de referencia directa (ej., objeto personal), presione 

“Direct match”             cuando añada la relación  

3e 

3c 

3d 

3f 

3g 

3d 

3e 

3g 



La búsqueda en DVI 
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4b 

• Presione Search 
• Elija las opciones             . Aquí, el umbral/límite es 0, así que veremos todos los 

resultados 
• Modelos de Posterior:               

AM driven: se tiene en cuenta a cada familia por separado  
PM driven: se tienen en cuenta a cada víctima por separado 
One-to-one: sólo dos hipótesis 

Nota: priors y posteriors no se aplican cuando se usa la herramienta Quick Scan, 
aunque aún se muestren en la pantalla. 

4a 

4a 

4b 

4c 

4c 

Ver diapositiva 
siguiente 



Modelos de Posterior en el ejemplo 
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AM driven 
H1 = la familia F1 está relacionada con V1 
H2 = la familia F1 está relacionada con V2 
H3 = la familia F1 está relacionada con V3 
H4 = la familia F1 no está relacionada con ninguna V 
H5 = la familia F2 está relacionada con V1 
H6 = la familia F2 está relacionada con V2 
H7 = la familia F2 está relacionada con V3 
H8 = la familia F2 no está relacionada con ninguna V 

V1 

V2 

V3 

MP
1 

MP
2 

F1 

F2 

PM driven 
H1 = V1 está relacionada con la familia F1 
H2 = V1 está relacionada con la familia F2 
H3 = V1 no está relacionada con ninguna familia 
H4 = V2 está relacionada con la familia F1 
H5 = V2 está relacionada con la familia F2 
H6 = V2 is no está relacionada con ninguna familia 
H7 = V3 está relacionada con la familia F1 
H8 = V3 está relacionada con la familia F2 
H9 = V3 no está relacionada con ninguna familia 

One to one 
H1 = Vn está relacionada con Fn 
H2 = Vn no está relacionada con Fn 
Vn = cualquier víctima 
Fn = cualquier familia 



Resultado del modelo de posterior AM driven 
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• Se obtienen primero los resultados de la primera familia (F1). 
• Se muestra el LR = P(datos ADN| MP pertenece a F1)/ P(datos ADN| MP no relacionada 

con F1) para todas las muestras no identificadas. 
 Para V1 y V3, LR=0, mientras que para V2, LR = 1/(2*0.25*0.25) = 8. 

• Para el cálculo del posterior se necesita un prior. En el ejemplo suponemos que a priori, 
V1, V2 y V3 tienen un prior de 0.25 de pertenecer a F1; la persona desaparecida puede 
ser alguien que no hemos encontrado con un prior de 0.25. La probabilidad a posteriori, 
P(V2 pertenece a F1| datos ADN)=0.89. 

• Las familias restantes, aquí sólo F2, se tratan de manera similar. 
 

Familias - Tutorial 



Cómo se definen priors en Familias 
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- Por defecto (use list), Familias tiene en 
cuenta el número de muestras sin 
identificar (3 en este caso) y además 
añade la posibilidad de que aún no 
hayamos encontrado a la persona 
desaparecida: 1 / 4 = 0.25 (como se 
mostró en la página anterior) 

- Se puede no seleccionar “use list” y 
añadir el tamaño deseado. Por ejemplo, 
si en este caso supiéramos que hay al 
menos 4 víctimas (aunque sólo 
encontráramos 3), podemos añadir “4” 
en la casilla “size”. Así, el prior será 1/5= 
0.20, para cada víctima.  

En la ventana “Add unidentified person(s) (PM)” 



Más: personas sin identificar – 
comparaciones 
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1 

2 
3 

Muy útil para re-asociar restos humanos (del mismo individuo) y/o detectar posibles 
relaciones entre las víctimas 
Ejemplo: 
Añadir un nuevo resto humano V4 con el mismo perfil que V1 (M1= 2-3) en la ventana 
“Add unidentified persons”         y click en “Blind search”.  Presionar “New search” y 
seleccionar la relación “Direct match” vs. “unrelated” para obtener         . Seleccionar las 
muestras y Click en “Merge samples”         (fusionar muestras) 

1 

2 
3 
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Fusionando muestras  

1 
4 

2 

3 
Obtendrá un resumen de las muestras.  
En el menú “Options” puede seleccionar: crear un perfil compuesto (       
opción “combine both”), usar el perfil de V1 o usar el perfil de V4. 
También puede renombrar este perfil combinado        . 
Click en “Merge”        y la muestra fusionada V1_V4 aparecerá ahora en 
la ventana “Unidentified persons”  

1 
2 

3 

4 

Comentario 
En este ejemplo V1 y V4 tienen el mismo 
perfi, pero en los casos reales es posible que 
una de las muestras no tenga el perfil 
completo. Este es el motivo por el que la 
opción “Combine both” está disponible 



Más – Familias de referencia 
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1 
2 

3 
4 

Se puede buscar sólo con las familias 
seleccionadas 
 
Para búsquedas globales (aún no disponible) 
 
Prepara en R los dibujos de lo pedigríes 
seleccionados 
 
Evalúa las familias de referencia, hace 
simulaciones y otras estadísticas 

1 

2 

3 

4 



DVI: importando datos desde archivos 
• Abra Familias e importe la base de datos de frecuencias: 

– Tools > General DNA data formato de archivo: http://familias.name/tutorial/database-dvi-tutorial.txt 

• Para importar las muestras sin identificar: 
– Tools > DVI module > Add  Unide…  formato de archivo: 

http://familias.name/tutorial/unidentified-dvi-tutorial.txt 

• Opción 1:  para importar personas de referencia con los datos genotípicos y luego 
introducir los pedigríes manualmente 
– Tools > DVI module > Add refe … Data only  

formato de archivo: http://familias.name/tutorial/ReferenceFamilies-dvi-tutorial.txt 

– Definir los pedigríes manualmente 

• Opción 2: para importar todos los datos de las familias de referencia (pedigríes 
incluidos) 
– Tools > DVI module > Add refe … Multiple families 

formato de archivo: http://familias.name/tutorial/pedigrees-dvi-tutorial.txt 

• La búsqueda puede hacerse después, obteniéndose los resultados anteriores. Se 
proporcionan más detalles sobre la importación de archivos en la sección 8 de este 
manual. 
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Nota: puede copiar y pegar los links en su 
buscador de internet y después guardar los 

archivos usando Ctrl+s en su teclado  Ctrl+s 

http://familias.name/tutorial/database-dvi-tutorial.txt
http://familias.name/tutorial/database-dvi-tutorial.txt
http://familias.name/tutorial/database-dvi-tutorial.txt
http://familias.name/tutorial/database-dvi-tutorial.txt
http://familias.name/tutorial/database-dvi-tutorial.txt
http://familias.name/tutorial/unidentified-dvi-tutorial.txt
http://familias.name/tutorial/unidentified-dvi-tutorial.txt
http://familias.name/tutorial/unidentified-dvi-tutorial.txt
http://familias.name/tutorial/unidentified-dvi-tutorial.txt
http://familias.name/tutorial/unidentified-dvi-tutorial.txt
http://familias.name/tutorial/ReferenceFamilies-dvi-tutorial.txt
http://familias.name/tutorial/ReferenceFamilies-dvi-tutorial.txt
http://familias.name/tutorial/ReferenceFamilies-dvi-tutorial.txt
http://familias.name/tutorial/ReferenceFamilies-dvi-tutorial.txt
http://familias.name/tutorial/ReferenceFamilies-dvi-tutorial.txt
http://familias.name/tutorial/pedigrees-dvi-tutorial.txt
http://familias.name/tutorial/pedigrees-dvi-tutorial.txt
http://familias.name/tutorial/pedigrees-dvi-tutorial.txt
http://familias.name/tutorial/pedigrees-dvi-tutorial.txt
http://familias.name/tutorial/pedigrees-dvi-tutorial.txt


7. Familial searching  
(búsqueda familiar) 
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1. General DNA data. Carga de la base de datos, es decir, frecuencias 
alélicas, etc. 

2. Profile database (base de datos de perfiles).  Individuos/muestras 
dubitadas en la base de datos de sospechosos. 

3. Traces (muestras dubitadas). Muestras sobre las que realizar la 
búsqueda familiar 

4. Search (búsqueda). Realizar la búsqueda e interpretar los 
resultados 
 

Pasos Básicos 
 



Ejemplo de Familial Searching 
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1. General DNA data:  
Un marcador con alelos 1 ,2, 3, 4 (todos con 
Frec.=0.25). 

2. Offender database:  
Tres muestras S1, S2 y S3, y sus genotipos. 

3. Target profile:  
Una muestra dubitada T1 con un genotipo que 
no coincide plenamente con ninguno de los 
sospechosos. 
 
 
 

• En este ejemplo “de juguete” ilustramos cómo se realiza la entrada de datos 
manualmente; es un ejercicio útil. 

• Para casos reales, los datos se importan desde archivos, como se explica después.  
Familias puede manejar bases de datos de >300,000 muestras. 

S1 

S2 

S3 

2/3 

1/3 

4/4 

T1 

3/3 
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Cómo introducir perfiles en este módulo 

C 

A 

Seleccione el primer sospechoso/traza y clic en «Edit DNA» para introducir el perfil 
En el módulo Familial Searching , los perfiles se introducen de manera diferente (ya que puede ser 
necesario añadir más de dos alelos en el caso de mezclas de ADN) 
Para introducir S1=2-3, tiene que: 
- Seleccionar «Allele 1» en el desplegable           y después seleccionar el valor          de este primer 

alelo (2, en este ejemplo). No presione Add aún 
- Select «Allele 2» en el desplegable y después seleccionar el valor de este segundo alelo (3, en este 

ejemplo). Ahora, presionar Add para obtener         .  
 

C 

A B 

B 
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Definiendo la base de datos de sospechosos 
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1 

Definir el marcador       , entrar en el módulo Familial searching  
 Añadir personas y perfiles genéticos              Presionar Next  

1 2a 

2b 2c 

2a 2c 
2b 

Editar perfil 



Definiendo los perfiles a comparar (target(s)) 
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• Defina el target, en este caso una muestra 
dubitada. 

 Presionar ’Add’  
• Edit los datos de ADN como se indica 
• Podemos fijar contribuyentes conocidos 

(ej. Víctimas en mezclas) 
 

4a 

4b 

4c 

4a 

4c 

4b 



Definiendo las opciones de búsqueda 
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• Especifique Parent-child               como la relación que queremos incluir en la búsqueda. 
• Fije el umbral de LR a 0 (cero)               y deje el resto de parámetros con sus valores por 

defecto. 
• Presione ’Next’ 

5b 

5a 

5c 

5a 

5c 

5b 
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Opciones avanzadas 
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Se puede usar un filtro IBS               para eliminar matches con bajo núm. de alelos IBS 
compartidos 
Se puede seleccionar «Examine kinships»              para que Familias realice una búsqueda 
informada entre los valores más probables de k0, k1 y k2. Esta búsqueda es 
computacionalmente intensiva y sólo se realiza para las relaciones que excedan el umbral 
de  LR. 

5d 

5e 

5d 

5e 



Búsqueda familiar – Resultados básicos 
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6a 

6c 

6b 

6d 

• Presione ’Search’ 
• Los resultados se muestran como matches entre un perfil/traza (target) y un candidato 

(persona de la base de datos). Los resultados se ordenan de acuerdo al valor del LR. 
Además se muestran otros datos 

• Puede investigar los resultados con más detalle               y puede crear informes. 

6a 

6b 

6c 6d 
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Búsqueda familiar – Resultados avanzados 

• Se pueden ver otros estadísticos de la búsqueda desplazándose hacia la derecha.  
• Alelos compartidos (total), así como la fracción de marcadores con 0, 1 o 2 alelos IBS 

• Si «Examine kinships» se ha activado en las opciones de búsqueda, se realiza una búsqueda dirigida que 
encuentra los valores IBD más probables así como el coeficiente de parentesco. 



Familial Search importando desde archivos 

• Abra Familias e importe la base de datos de frecuencias: 
– Tools > General DNA data formado del archivo: http://familias.name/tutorial/database-dvi-

tutorial.txt 

• Importe la base de datos de sospechosos 
– Tools > Familial searching > Import formato del archivo: http://familias.name/tutorial/offenders-fs-

tutorial.txt 

• Importe el perfil target 
– Tools > Familial searching > Next > Import 

formato del archivo: http://familias.name/tutorial/target-fs-tutorial.txt 

• La búsqueda ya puede hacerse, obteniéndose los resultados anteriores. Se 
proporcionan más detalles sobre la importación de archivos en la sección 8 de este 
manual. Familias puede manejar archivos .xml de CODIS. 
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Recuerde: puede copiar y pegar los links en 
su buscador de internet y después guardar 

los archivos usando Ctrl+s en su teclado  

http://familias.name/tutorial/database-dvi-tutorial.txt
http://familias.name/tutorial/database-dvi-tutorial.txt
http://familias.name/tutorial/database-dvi-tutorial.txt
http://familias.name/tutorial/database-dvi-tutorial.txt
http://familias.name/tutorial/database-dvi-tutorial.txt
http://familias.name/tutorial/offenders-fs-tutorial.txt
http://familias.name/tutorial/offenders-fs-tutorial.txt
http://familias.name/tutorial/offenders-fs-tutorial.txt
http://familias.name/tutorial/offenders-fs-tutorial.txt
http://familias.name/tutorial/offenders-fs-tutorial.txt
http://familias.name/tutorial/target-fs-tutorial.txt
http://familias.name/tutorial/target-fs-tutorial.txt
http://familias.name/tutorial/target-fs-tutorial.txt
http://familias.name/tutorial/target-fs-tutorial.txt
http://familias.name/tutorial/target-fs-tutorial.txt


8. Archivos para importar (formatos) 
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8.1 Archivo con la base de datos de 
frecuencias 
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Todas las versiones de Familias reconocen en formato estándar. Este formato 
se describe en la figura y se guarda como archivo de texto. 

Estándar (datos separados por tabulaciones) 
 



88 Familias - Tutorial 

El formato matriz es el que comunmente se encuentra en las publicaciones 
de frecuencias  alélicas. Es muy importante el identificador de alelo o 
alelos, arriba a la izquierda. 

Con formato de Matriz 
 



8.2 Archivo con los datos del caso 
(Case data input, samples) 
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Este tipo de archivo se puede crear fácilmente en Excel (o herramienta 
similar) y se debe guardar como archivo de texto separados por 
tabulaciones. Abajo puede ver un ejemplo del formato. 

Datos separados por tabulador 1 
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Familias también permite archivos de texto separado por tabuladores pero 
con una sola columna por marcador.  
Puede ver el formato a continuación. 

Datos separados por tabulador 2 
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Familias puede importar datos de perfiles desde GeneMapper (o datos con 
formato similar al de GeneMapper). El formato exacto se describe en la 
figura. 

GeneMapper 
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Familias reconoce el formato xml de 
CODIS. A la derecha se muestra un 
ejemplo de este formato, en el cual 
puede ver las etiquetas (tags) 
necesarias. No son necesarias otras 
etiquetas (normalmente añadidas 
por CODIS). 

 
 
Puede encontrar un ejemplo en 
http://familias.name/Files/example.xml 

Formato XML 

http://familias.name/Files/example.xml


8.3 Datos de las Familias de referencia 
(DVI) 
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Familias reconoce algunas relaciones de parentesco estándar que se pueden 
definir en los archivos que se van a importar. Abajo puede ver el listado 
exhaustivo. Por favor, tras la importación, compruebe todos los datos para 
asegurarse de que Familias los ha interpretado correctamente. Puede ver 
un ejemplo en la página 83. 
 

[Father], [Mother], [Parent], [Son], [Daughter], [Child], [Sister], [Brother], 
[Sibling],  [Half Sister], [Half Brother], [Half Sibling], [Direct], [Identity], 
[Paternal Half Sister], [Maternal Half Sister], [Maternal Half Brother], 
[Paternal Half Brother], [Grandmother], [Grandfather], [Paternal 
Grandmother], [Maternal Grandmother], [Paternal Grandfather], 
[Maternal Grandfather], [Grandson], [Granddaughter], [Grandchild], 
[Uncle], [Aunt], [Niece], [Nephew], [Wife], [Husband], [Spouse] 

Relaciones familiares 
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 Similar a los archivos separados por tabulación 
descritos anteriormente para la entrada 
estándar de datos de ADN. Se pueden incluir 
varios individuos en el mismo archivo. Nota, no 
se puede incluir información sobre la familia, 
cada individuo se coloca en una familia. Se 
puede incluir una línea especificando la 
relación de parentesco con la persona 
desaparecida, como puede verse abajo. 

Importación Simple 
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El formato se ha descrito anteriormente para la entrada estándar de datos de 
ADN. Esta versión reconocerá las categorías de CODIS y creará las 
relaciones familiares basándose en la información de CODIS. 

CODIS xml 
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Este formato se parece al formato Simple, pero añade una columna para 
designar el nombre de la familia, ver abajo. 

Sólo Datos 
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Este formato es una extensión del formato «sólo datos», pero incluye una 
columna adicional para especificar el parentesco con la persona 
desaparecida dentro de cada familia, ver figura abajo. 

Varias familias 
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Esta opción le permite importar un proyecto de Familias estándar con los 
datos de ADN y los pedigríes. Familias creará automáticamente las 
familias (una por cada archivo de Familias). La persona desaparecida debe 
denominarse MISSING PERSON. 

Proyectos de Familias 
 



9. Archivos exportados e informes 
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9.1 Informes generados por Familias 
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Es el formato estándar de Familias, es decir, el formato en el que Familias 
genera los informes. Se puede generar para que incluya diferente tipo de 
información: (i) simple, que contiene sólo información sobre los LRs y los 
pedigríes y (ii) extenso, que contiene toda la información necesaria para 
reproducir los resultados. 

Con la extensión rtf, lo que se genera realmente es un archivo .txt y por lo 
tanto no se trata de un archivo  con el texto formateado. 

Formato rtf 
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Este formato genera un archivo separado por comas (csv). Se muestra un 
ejemplo en la figura.   

Formato csv 
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Este formato genera un archivo separado por tabulaciones. Se muestra un 
ejemplo en la figura.   

Formato tab 
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Este formato genera un archivo xml de contenido integral. El archivo se puede 
abrir también como un proyecto de Familias. Se muestra un extracto en la 
figura.   

Formato xml 
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Listado de Pedigríes 

Este formato genera archivos de 
texto separado por tabuladores 
con el listado de todos los 
pedigríes, así como de los 
likelihoods, los LRs y los 
posteriors (si están disponibles) 



9.2 Otros 
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Hay varios diálogos/ventanas que permiten exportar la tabla de resultados 
completa, por ejemplo  los resultados de una búsqueda en el módulo DVI. 
Este tipo de exportación genera simplemente un archivo .txt separado por 
tabulaciones que puede procesarse después en Excel o una herramienta 
similar.  

 
Estas exportaciones se explican por sí mismas. 

Archivos Generales 
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Hay varios diálogos/ventanas que permiten exportar resúmenes, por 
ejemplo, el módulo Blind Search permite al usuario generar un resumen 
de los resultados de una búsqueda, como también lo hace el módulo DVI 
en las búsquedas. 

Informes resumen 
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El módulo Blind Search permite la exportación de una matriz de distancia. La 
matriz será de n x n elementos, siendo n el número de individuos en la 
búsqueda. La matriz compara todos los individuos y calcula, o bien, 

1. La distancia IBS entre dos genotipos 
2. El coeficiente de parentesco, estimado usando una aproximación de 

máxima probabilidad 
3. Las estimas kappa2 y kappa0, usando el mismo método que en 2. 

Exportación de matriz 
 



10. Avanzado 
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En Familias hay algunas opciones/configuraciones avanzadas, a las que puede 
acceder vía  
File -> Advanced, vea la figura de la página siguiente. Algunas 
configuraciones están destinadas a usuarios expertos. 

Descripción 
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View mutation matrix – para ver y/o guardar la matriz de mutación de los marcadores definidos. 
Save genotype data – Decide si se guardan o no los genotipos de las simulaciones 
Save complete data – Decide si se guarda o no todo el dato bruto (genotipos y probabilidades) de una simulación 
Dropout – Habilita un modelo logístico de dropout en el que se necesitan las alturas de pico (se puede importar usando sólo el formato 

Genemapper). Sólo recomendado para usos avanzados. 
Step dropout probability – Si se habilita junto con el dropout en un perfil, Familias calculará el LR para un rango de probabilidades de 

dropout (similar a un análisis de sensibilidad, sensitivity analysis).  
DVI  options – Por defecto se habilita una función de búsqueda rápida en la que Familias primero calcula los LRs descartando mutaciones y 

después teniendo en cuenta la mutación en los marcadores en los que la probabilidad es cero. Aquí se configura también el número 
permitido de mismatches para que aún así Familias lleve a cabo el cálculo. Si deshabilita esta característica el tiempo de computación se 
puede extender. 

Number of decimals – Configura el número de decimales que se muestran y guardan cuando los números son relevantes. 
Force minor allele frequency – Si se habilita, Familias forzará el uso de frecuencias mínimas (definidas para cada marcador) cada vez que una 

frecuencia alélica está por debajo de este valor. Advertencia! Puede causar que la suma de las frecuencias alélicas sea mayor que 1. 
New Alleles – Recuerda la elección cada vez que se detecta un alelo nuevo. Por ejemplo, la misma frecuencia para todos los alelos nuevos 
Debug mode - Esto activará algunas opciones de depuración, principalmente mediante el volcado de archivos en el directorio de instalación 
de Familias. 
Direct/Identity matches – Valores usados en la comparación directa. También se pueden cambiar en la ventana de diálogo de Blind Search. 
Allele lumping – No implementado actualmente. Si se habilita causará el agrupamiento de alelos, lo cual producirá tiempos de computación 
más cortos. El agrupamiento es una aproximación por la cual todas las transiciones/mutaciones con una probabilidad menor que un umbral 
se agrupan. 



11. Miscelánea 
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Crear una base de datos de 
frecuencias 
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• File > Create database se puede usar para 
• Crear una base de datos de frecuencias alélicas 
• Proporcionar parámetros estadísticos poblacionales, como heterocigosidad 
• Realizar búsqueda ciega con los perfiles del estudio poblacional 

• Ejemplo simple (file) basado en una muestra de 10 individuos analizados para dos 
marcadores. 

 
 
 

 
 

• Importar: File > Create database > Import 
• Crear un archivo de Familias: File > Create database > Create 
• Parámetros estadísticos: File > Create database > Statistics 

Tel archivo contiene info sobre parámetros estadísticos abajo del todo y se puede 
importar a Familias 

• Realizar blind search: File > Create database > Check data 

https://familias.name/tutorial/database-creation-example-small.txt


Más información en: http://familias.no, 
http://familias.name y en los libros: 
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Relationship inference Mass Identifications 

http://familias.no/
http://familias.name/
http://store.elsevier.com/product.jsp?isbn=9780128024027
https://www.elsevier.com/books/mass-identifications/kling/978-0-12-818423-3


Links útiles 
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Bases de datos (listas para usar): 
- Noruega 
- Somalí: Noreste de África (Somalia, Etiopía, 
Eritrea) 
- Asia central (Pakistán/Afganistán) 
- Sureste de Asia (Tailandia, Vietnam) 
- Española  
 

Elias Hernandis ha diseñado una herramienta muy 
útil para convertir y producir archivos de datos para 
Familias (y otros programas). Ver 
https://leapdna.org/.  

http://familias.name/Familias_databases/Norwegian_DB.fam
http://familias.name/Familias_databases/Somali_DB.fam
http://familias.name/Familias_databases/Somali_DB.fam
http://familias.name/Familias_databases/Somali_DB.fam
http://familias.name/Familias_databases/Middle_Asia_DB.fam
http://familias.name/Familias_databases/Southeast_Asia_DB.fam
http://familias.name/Familias_databases/Southeast_Asia_DB.fam
http://familias.name/Familias_databases/Spanish_DB.fam
http://familias.name/Familias_databases/Spanish_DB.fam
https://leapdna.org/


Artículos que hacen referencia a 
Familias. Validación. 

Familias - Tutorial 119 

Puede ser útil consultar artículos que mencionan Familias 
Se puede obtener un listado actualizado aunque no exhaustivo en: 

Referencias al artículo de Egeland et al. (2000) 
Referencias al artículo de Kling et al. (2014) 

Puede ver la validación de software para parentesco, Familias incluido, en: 
Drabek (2008) 

https://scholar.google.com/scholar?cites=16640506541668228170&as_sdt=2005&sciodt=0,5&hl=en
https://scholar.google.com/scholar?cites=16640506541668228170&as_sdt=2005&sciodt=0,5&hl=en
https://scholar.google.com/scholar?cites=16640506541668228170&as_sdt=2005&sciodt=0,5&hl=en
https://scholar.google.com/scholar?cites=971745121205496116&as_sdt=2005&sciodt=0,5&hl=en
https://scholar.google.com/scholar?cites=971745121205496116&as_sdt=2005&sciodt=0,5&hl=en
https://scholar.google.com/scholar?cites=971745121205496116&as_sdt=2005&sciodt=0,5&hl=en
https://pubmed.ncbi.nlm.nih.gov/19215880/
https://pubmed.ncbi.nlm.nih.gov/19215880/

